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Riku Katainen1,2*, Iikki Donner1,2, Tatiana Cajuso1,2, Eevi Kaasinen1,2, Kimmo Palin1,2,
Veli Mäkinen3, Lauri A. Aaltonen1,2, Esa Pitkänen1,2,4*
Next-generation sequencing (NGS) is routinely applied in life sciences and clinical practice, but interpretation of the
massive quantities of genomic data produced has become a critical challenge. The genome-wide mutation analyses
enabled by NGS have had a revolutionary impact in revealing the predisposing and driving DNA alterations behind a
multitude of disorders. The workﬂow to identify causative mutations from NGS data, for example in cancer and rare
diseases, commonly involves phases such as quality ﬁltering, case–control comparison, genome annotation, and visual
validation, which require multiple processing steps and usage of various tools and scripts. To this end, we have introduced
an interactive and user-friendly multi-platform-compatible software, BasePlayer, which allows scientists, regardless of
bioinformatics training, to carry out variant analysis in disease genetics settings. A genome-wide scan of regulatory
regions for mutation clusters can be carried out with a desktop computer in ~10 min with a dataset of 3 million somatic
variants in 200 whole-genome-sequenced (WGS) cancers.

Introduction
DNA alterations have been studied for decades to unravel the mechanisms underlying disease
development as well as cellular and evolutionary processes. NGS technologies have increased the
scale of genetic studies by multiple orders of magnitude and are at present widely applied in
the life sciences. These developments have resulted in the availability of massive amounts of
sequencing data for research and clinical use1. A fundamental challenge in disease genetics is the
identiﬁcation of a variant or variants causative of the disease or phenotype. Putative causative
mutations in the germ line typically possess characteristics such as low allele frequency in the
population, overrepresentation in cases versus controls, and, in the case of coding mutations, a
damaging effect on the relevant protein2. Although the genetic basis of many of the ~7,000 rare
diseases affecting >300 million people worldwide is still unknown, NGS is rapidly accelerating the
discovery of the missing determinants2. At the same time, NGS is driving cancer genetics and
genomics. For instance, one can utilize evidence of selection, such as clonality and unexpectedly high
degrees of mutation recurrence in a gene or genomic region, to detect somatic driver mutations in
cancer3. NGS techniques are also rapidly highlighting the role of somatic mutations in other disorders, such as clonal hematopoiesis4.
Owing to numerous error-prone experimental and computational steps that must be taken to
obtain variants from DNA or RNA sequences5, variant calling is often imperfect6. Variant calling is
particularly difﬁcult in low-complexity and homologous genomic regions, which are abundant in the
noncoding genome, thus complicating the analysis of noncoding variants7. In addition, variant calling
can be hampered by sample heterogeneity, subclonality and copy-number variation, among other
factors8. Well-established workﬂows, such as Broad GATK, facilitate primary analysis of sequence
data by providing variant call format (VCF) ﬁles annotated with quality information9 (Fig. 1). NGS
data providers such as core facilities and companies commonly provide analysis-ready sequence
alignment (BAM) and VCF ﬁles. However, ﬁltering by quality values alone is often insufﬁcient, and
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Fig. 1 | Overview of the NGS data analysis capabilities and features of BasePlayer. Sample preparation and NGS pipeline procedures, including read
alignment and variant calling, are required to be performed before BasePlayer analysis. BasePlayer supports the standard ﬁle formats used in NGS data
analysis, e.g., BAM and VCF ﬁles, as input ﬁle types. Ensembl reference genomes and gene annotations can be downloaded and installed automatically
in the BasePlayer user interface. RefSeq reference genomes can be imported through the user interface as FASTA ﬁles and gene annotations as GFF or
GTF ﬁles. Other external resources, such as ClinVar, chromatin immunoprecipitation sequencing (ChIP-seq), ATAC-seq and Repli-seq data, are
available from, e.g., ENCODE and Roadmap Epigenomics can be imported into BasePlayer as annotation tracks (Step 4B(ii)). Variant control data can
be obtained from, e.g., gnomAD or 1000 Genomes project websites. It is also possible to use and create a multi-sample-vcf ﬁle for this purpose.
BasePlayer has a multitude of features for analysis, visualization and integration purposes listed at the bottom of the ﬁgure. ATAC-seq, assay for
transposase-accessible chromatin sequencing; TT-seq, transient transcriptome sequencing.

additional processing, such as comparison of variants between samples, ﬁltering of problematic
genomic regions (e.g., repeats) and visual inspection of sequence reads, is required. In addition, the
size and complexity of the NGS data in a typical study impose a substantial burden on the analysis
software and user interface.
Addressing these challenges requires integrative analysis of variant and sequence data. This
analysis typically consists of multiple ﬁltering, annotation and comparison steps involving variant
data (VCF ﬁles) and inspection of BAM ﬁles. To this end, we have introduced a cross-platform
graphical software, BasePlayer (https://baseplayer.ﬁ) that is designed to streamline biological discovery by enabling researchers to perform comparative genomic variant studies for human or any
other species with an assembled and annotated reference genome10–12; see Supplementary Table 1 for
a list of publications in which BasePlayer has been utilized. Distinguishing itself from other tools,
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BasePlayer offers an interactive approach to variant analysis: the effect of adjusting analysis parameters is visualized by the user interface in real time, guiding parameter choices and accelerating the
analysis process. Because NGS data from even a single individual can be very large—a WGS human
chromosome may contain >300,000 germ-line variant calls—interactive visualization and analysis of
such data require particularly efﬁcient data structures and algorithms. With this in mind, BasePlayer
is able to visualize variants of hundreds of exome-sequenced and dozens of WGS human individuals
at the chromosomal level in real time due to careful design choices.
BasePlayer is well suited for the analysis of germ-line and somatic variants in both the coding and
noncoding genome. Identiﬁcation of rare causative germ-line variants with large effects typically takes
only 10–20 min, including the software download and installation. If pedigree information is
available, both coding and noncoding variants can be ﬁltered according to the assumed pattern of
inheritance, for instance, an autosomal recessive or X-linked dominant pattern, expediting causative
variant discovery (Step 4A, Supplementary Tutorial 1 and Supplementary Fig. 1). To detect coding
and noncoding somatic variants of relevance, for example, in cancer or clonal hematopoiesis, it is
similarly quick to ﬁnd genes or regions frequently mutated in the cohort, as well as clusters of variants
(e.g., mutation hotspots; see Step 4B)13. Additional layers of data can be imported to guide the
analysis further; for instance, DNA–protein interaction data can be used to screen for variants
occurring at regulatory regions11, haplotypes shared between affected individuals can be used to
pinpoint an inherited mutation or third-generation long-read sequencing data (generated by, e.g.,
Oxford Nanopore or Paciﬁc Biosystems instruments) can be used to allow visual inspection of the
consequences of structural variation (Supplementary Fig. 2)14. No expertise in bioinformatics or
programming is required to use the software in common use cases. A brief video introducing the
software can be viewed at the BasePlayer Youtube channel (‘BasePlayer Trailer’, https://www.youtube.
com/channel/UCywq-T7W0YPzACyB4LT7Q3g/videos).

Overview of the procedure
We demonstrate the capabilities of BasePlayer with two distinct disease genetics analysis scenarios in
the Procedure (Cases 1 and 2, as described further below), both performed with an ordinary desktop
computer and with 1 GB of allocated memory. Although these cases show how to replicate two
previously published ﬁndings11,15 using BasePlayer, the Procedure can be readily adapted to a wide
variety of settings. In the ﬁrst case, we show a procedure for ﬁnding the predisposing mutation in a
family with an inherited disease (meningioma), assuming autosomal dominant inheritance, replicating a previous study described in Aavikko et al.15 BasePlayer also supports other standard
inheritance patterns, such as autosomal recessive and X-linked inheritance (Supplementary Tutorial 1
and Supplementary Fig. 1). Here, the procedure is used to ﬁnd candidates for a causative, nonsynonymous mutation, which is assumed to segregate in the family, reside in a haplotype shared
between cases (e.g., linkage-compatible region) and have a very low allele frequency in the general
population. The dataset used in the original study included three exome-sequenced germ-line samples
from the affected siblings, as well as genome-wide linkage analysis data for the same family15. This
procedure demonstrates how to exploit BasePlayer’s ability to perform between-sample variant
comparison to identify variants shared between cases. The procedure also shows how gene and ROI
(e.g., shared haplotypes) annotation and large-scale population variant databases can be used to
narrow down the list of candidates (in the Procedure, we use the publicly available data from the
gnomAD/ExAC project; see Materials)16. Required ﬁles for this procedure are variant (VCF) ﬁles for
cases and controls, BAM ﬁles for read-level visual inspection of the data and a BED ﬁle for the
genomic regions shared by affected family members (linked regions). A real-time demonstration
video for this case can be viewed at the BasePlayer Youtube channel (‘Familial variant study with
BasePlayer’, https://www.youtube.com/channel/UCywq-T7W0YPzACyB4LT7Q3g/videos).
In the second case, we analyze somatic variants in WGS cancer genomes. We describe a procedure
to ﬁnd somatic mutations with a possible role in tumor development by detecting recurrent
mutations within genomic regulatory regions. Regulatory regions can be speciﬁed using data from,
for example, the ENCODE Project17. This procedure replicates a study that was originally
performed with somatic variant calls of 190 WGS colorectal cancers11. Required ﬁles for this
procedure are somatic variant (VCF) ﬁles for cases, BAM ﬁles (tumor and normal WGS data) for
read-level inspection, and a BED ﬁle for ENCODE regulatory and transcription factor (TF)–binding
data18 (see Materials). A real-time demonstration video of this analysis can be viewed at
the BasePlayer Youtube channel (‘Somatic cluster analysis demonstration with BasePlayer’,
2582
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https://www.youtube.com/channel/UCywq-T7W0YPzACyB4LT7Q3g/videos). In addition to these
two studies, earlier versions of BasePlayer have been used in at least 23 publications (Supplementary
Table 1).

Applications of the method
Owing to an extensive supply of population-control genotypes, as well as gene and regulatory
annotations available in public databases, BasePlayer has found most use in human disease genetics
research settings (Supplementary Table 1). However, BasePlayer is applicable to any variant analysis
setting in which an assembled and annotated reference genome is available. To facilitate nonhuman
applications, Ensembl reference genomes and gene annotation ﬁles can be downloaded and used in
BasePlayer directly from the user interface (Step 3).
In addition to the two procedures presented here, BasePlayer can be used in a wide variety of tasks
encountered in genetics, such as population-level polymorphism analyses, mutation burden analysis
for genes, mutation screening and analysis of structural variant breakpoints and target sites. For
instance, genotypes obtained using non-NGS techniques (e.g., SNP arrays) can be imported and
analyzed as VCF ﬁles.
The advent of third-generation sequencing (e.g., Oxford Nanopore, Paciﬁc Biosciences) has
enabled investigation of genomic regions and events for which analysis with short-read data is not
feasible. Reads that are thousands of base pairs long are nontrivial to visualize, as a single read can
span multiple genomic breakpoints, or multiple exons in the case of RNA data. BasePlayer natively
supports long-read data. For instance, the researcher can divide the main screen between distinct
genomic loci by double-clicking a read that has been mapped to multiple locations (Supplementary
Fig. 2). A demonstration video on how to visualize long-read data in BasePlayer can be viewed at the
BasePlayer Youtube channel (‘Third-generation sequencing data visualization with BasePlayer’,
https://www.youtube.com/channel/UCywq-T7W0YPzACyB4LT7Q3g/videos). All split views are
equally functional and contain gene annotation. This functionality can be used to, for example, search
for fusion genes or targets of structural variants. In addition, BasePlayer visualizes the whole
DNA fragment with respect to its split-mapped components in an inset information box (Supplementary Fig. 2).
Mitochondrial genetic diseases often show heteroplasmy, in which the disease manifests only when
the abundance of mutated mtDNA molecules exceeds a certain threshold19. Given a cohort with
mitochondrial DNA sequences, BasePlayer can be used to remove common mitochondrial variants
and screen for the highly mutated allelic fraction in the remaining variants. If familial cases are
available, BasePlayer can further ﬁlter for variants following a mitochondrial, or maternal, inheritance
pattern to narrow down the list of candidate variants.
Comparison with other methods
BasePlayer combines features of different variant data manipulation and annotation tools, as well as
visualization software packages and genome viewers into a single genetic analysis software. It
incorporates annotation and ﬁltering methods implemented in command-line tools such as Annovar,
bedtools and VCFtools that were developed to manipulate and integrate VCF and BED ﬁles20–22.
These methods include gene annotation, intersection and subtraction of genomic regions, allele
frequency ﬁltering and masking, and variant comparison. BasePlayer offers these features in a graphical interface, which reﬂects the parameter settings (e.g., annotations and ﬁlters in use) in real time.
This allows the annotation and ﬁltering parameters to be adjusted during the analysis without the
need to create new VCF ﬁles after each adjustment of the ﬁltering parameters, in contrast to
command-line tools. Unlike many other variant analysis tools, BasePlayer has a built-in method to
predict afﬁnity changes at TF-binding sites in response to variants (see Supplementary Tutorial 2 and
Supplementary Fig. 3). Core features include identiﬁcation of variants shared between samples (e.g.,
at least ﬁve samples must share the variant) and genes that are recurrently mutated across samples
(e.g., at least ﬁve samples carry a truncating variant in a gene). Furthermore, as demonstrated in Case
2 (Step 4B), BasePlayer is able to scan the genomes for clustered variants11. BasePlayer is also able to
output the nucleotide sequence context for each variant (e.g., 5′–A[C>T]G–3′) for downstream
mutation signature analysis23.
BasePlayer tightly integrates variant analysis with data visualization, providing a low-latency builtin genome browser with separate visualization tracks for variants, sequencing data and genome
annotation (provided as BEDs or BedGraphs, for example). There are several data visualization tools
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and genome browsers available, such as IGV, Tablet, Artemis, Savant Genome Browser and GenomeView24–28. Despite our focus on genetic analysis, BasePlayer’s read data and variant visualization
performance is comparable to those of these browsers in terms of latency, owing to the efﬁcient data
structures and design choices made in the software (e.g., the number of split screens is limited only by
the width of the monitor screen). VCF and BAM ﬁles from the same sample are combined and
displayed in a single, sample-speciﬁc track; this and other design choices allow the user to view
variants in hundreds of samples simultaneously. There are tools currently under development, such as
seqr, VarAFT and SeqsLab (https://seqr.broadinstitute.org/, https://varaft.eu/, https://www.biorxiv.
org/content/early/2017/12/27/239962, respectively), that focus on variant annotation, ﬁltering and
analysis, underlining the need for such software platforms. Unlike BasePlayer, these tools do not
integrate interactive variant visualization with analysis and seem to currently support only human
analyses, mainly focusing on the coding regions, limiting their applicability. Furthermore, tools have
been developed for speciﬁc tasks in which variant and sequence data must be integrated. One example
is Viper, which allows visual validation of variants against NGS data29. BasePlayer improves on Viper
by allowing more than one BAM ﬁle to be examined at the same time at the same locus interactively,
together with genomic annotation data, a critical feature when validating cancer somatic variants, for
example (see Case 2, Step 4B(ix) and https://baseplayer.ﬁ/BPmanual/content/ui.html#tbrowser). In
many external server or cloud-based analysis platforms, such as BaseSpace (https://basespace.
illumina.com/), SeqsLab and Chipster30, the data reside in the cloud, complicating analysis of sensitive or massive data. To address such scenarios, BasePlayer is fully portable, and neither an active
network connection nor registration is needed. Mutation-ranking tools such as OncodriveFML,
Genomiser/Exomiser and FunSeq2 are designed to score and annotate the disease-causing potential
of variants in the human genome31–33. These tools can be useful for discovering potential causative
mutations. Although BasePlayer does not implement a variant-ranking functionality, annotations
from external tools can be imported as annotation tracks and used to ﬁlter variants. Moreover,
BasePlayer is able to output variants in a format accepted by OncodriveFML as input31.
BasePlayer’s ﬂexible and interactive user interface facilitates rapid discovery of candidate causative
mutations from variant data. It also allows large-scale comparative genetic analyses to be performed
with an ordinary desktop computer by a single person with basic computing skills. To facilitate
disease genetics, BasePlayer supports analysis under single-gene inheritance patterns such as autosomal dominant and recessive patterns in familial data (see Step 4A(v), Supplementary Tutorial 1 and
Supplementary Fig. 1). Pedigree-based analysis is also available in seqr (Broad). Whereas seqr
focuses on human familial diseases, BasePlayer also supports other species and is not restricted to
familial analyses.

Limitations
BasePlayer does not annotate the variants with predicted functional impact on the protein (e.g.,
neutral or damaging). However, it is possible to create a VCF ﬁle in BasePlayer that contains the
results of BasePlayer analysis, and to analyze the variants further in Ensembl Variant Effect Predictor
or any variant-impact prediction tool that accepts VCF input. In addition, annotations from public
databases or tools, such as dbSNP, ClinVar, ICGC, COSMIC and PubMed, and pathogenicity predictors can be viewed at the VarSome website (https://varsome.com/) by clicking the variant in the
‘result table’ or in the sample track (see Procedure, Case 1). Alternatively, it is possible to ﬁlter or
annotate variants in BasePlayer by their predicted impact with annotation tracks prepared for this
purpose. Impact scores from three recent databases can be used to score variants by their predicted
impact: CADD, DANN and M-CAP34–36. See Supplementary Tutorial 3 and Supplementary Fig. 4 for
instructions on how to install these resources.
BasePlayer allows interactive visualization of all variants in all samples on a single chromosome at
once. However, this ability is the most CPU- and memory-intensive feature of the software and may
cause interactive usage to appear sluggish when a large number of samples are opened at the same
time, depending on the available CPU and memory resources. In our use, we routinely analyze
hundreds of WGS samples in BasePlayer using 1.2 GB (maximum memory allocation in 32-bit
systems) of allocated memory. To analyze a larger dataset, more memory must be allocated to the
software. For instance, BasePlayer consumes ~2.3 GB of memory when ~28 million somatic singlenucleotide variants (SNVs) in 2,700 WGS cancers have been loaded. If the memory consumption is
excessive, BasePlayer disables the variant visualization but is still able to analyze and annotate variants
in batches (default window size = 1 Mbp) and write the annotated results directly to a ﬁle.
2584
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BasePlayer’s approach to ﬁltering candidate variants by population genotypes, inheritance patterns
and layers of domain-speciﬁc data facilitates the discovery of rare causative variants, especially those
with large effects. Numerous methods for rare-variant association testing have been developed to
identify predisposing variants when effect sizes are expected to be smaller (e.g., SKAT-O37). Although
BasePlayer does not yet directly implement such techniques, it can still be used as a quality control,
and to ﬁlter and annotate variants before carrying out any association test that supports VCF input
format. Conversely, candidate variants highlighted by an association test can be imported into
BasePlayer to ﬁlter, annotate and visually inspect candidates together with additional layers of data. In
summary, analyses conducted using statistical techniques or BasePlayer are not mutually exclusive
but can instead complement each other.
Finally, because BasePlayer is operated through a graphical user interface and does not currently
offer an application programming interface, it cannot be included as a part of automated analysis
pipelines or scripts, unlike command-line tools.

Experimental design
Input data formats
A typical BasePlayer session involves matched NGS data and variant calls together with control
genotypes and genomic regions, which can be used to ﬁlter the candidate variants (Fig. 1). Standard
VCF ﬁles compressed with bgzip and indexed with Tabix are required for variant analysis38. VCF ﬁles
are created by many types of variant-calling and annotation software, including GATK HaplotypeCaller, Torrent Variant Caller plug-in (IonTorrent) and Mutect8,9. To visualize read sequence data
and sequencing coverage, indexed BAM ﬁles are required. BAM ﬁles are created by short-read
aligners such as BWA or Bowtie, or by NGS workﬂows such as GATK9,39,40. We recommend
preparing a pair of VCF and BAM ﬁles for each sample (case) to be analyzed, giving them an identical
ﬁle name preﬁx and placing them in the same folder together with the respective index ﬁles (i.e., the
sample folder should contain samplename.vcf.gz, samplename.vcf.gz.tbi, samplename.bam and
samplename.bam.bai). With this setup, the VCF and BAM ﬁles from the same sample are matched,
and read data are visualized alongside the variants in the sample track. In Unix environments, ﬁle
links can be used to arrange data located in multiple folders to be accessible from a single folder.
Variant ﬁltering
To ﬁlter variants that are common in the population, it is possible to use reference variant data in
BasePlayer. Set the allele frequency threshold to reﬂect the characteristics of the studied disease, such
as incidence rate. We provide a snapshot of the Genome Aggregation Database (gnomAD) for the
human genome GRCh37 containing whole-genome variants of n = 15,496 and whole-exome variants
of n = 123,136 individuals (see Downloads at https://baseplayer.ﬁ). To reduce processing and
download times, as well as ﬁle sizes, we removed all other information (e.g., gene annotations) except
allele frequencies from the gnomAD VCF ﬁles and merged all remaining data into a single ﬁle. This
preprocessing is for convenience only: gnomAD data available at http://gnomad.broadinstitute.org/
downloads can be used in BasePlayer without any preprocessing steps. It is also possible to create
user-deﬁned control ﬁles (multi-sample VCFs) in BasePlayer as follows: open multiple control sample
VCF ﬁles (e.g., samples from healthy family members or general population) and set the variant ﬁlter
thresholds to zero to include low-quality variant calls in the control ﬁle. This strategy allows for
effective ﬁltering of technical artifacts in the data, otherwise abundant in regions that are difﬁcult to
sequence. Then, annotate all variants and write the results to a VCF ﬁle. The resulting VCF ﬁle can be
opened as a control track (see Step 4A(iii) for more details).
In the case that only a subset of genes are of interest, create a text ﬁle (.txt) containing names or
ENSG (Ensembl gene identiﬁers) codes for the desired genes, add the ﬁle as an annotation track and
apply the track to exclude variants outside the genes of interest (Step 4A(ii)).
Quality-ﬁltering thresholds (e.g., minimum (min.) coverage, min. quality score and min. allelic
fraction) depend on the sequence data type and quality. Lower thresholds increase ﬁltering sensitivity,
but lower speciﬁcity. For instance, the allelic fraction threshold can be set higher in germ-line variant
analysis (e.g., 20%) than in analysis of subclonal somatic variation (e.g., 5%).
Data integration
Genomic data other than sequencing or variant data can be opened in BasePlayer as tracks.
BasePlayer supports standard ﬁle formats, including BED, BedGraph, bigWig, bigBed, GFF and
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tab-separated (TSV) formats. This allows integration of data from various experiments and analyses
into variant analysis, for instance, peak calls from DNAse-seq, MNAse-seq and ChIP-seq experiments; methylation levels from whole-genome bisulﬁte sequencing or methylation array experiments;
regions spanned by copy-number and structural variants; replication timing (e.g., Repli-seq); chromatin segmentation (e.g., ChromHMM); repeats (e.g., RepeatMasker); mappability; and genomic loci
of speciﬁc interest (e.g., known pathogenic variants in ClinVar, candidate genes). These data can then
be used to annotate and ﬁlter variants and, together with NGS data and variants, to provide a uniﬁed
view of the genomic landscape of the study subjects.
Variant annotations
Amino acid changes are calculated, and gene information is added to variants using indexed reference
sequence (FASTA) and gene annotation (GFF3), which are loaded by default when BasePlayer is
launched. The gene annotation ﬁle contains, among other things, chromosomal positions and codon
phases for all protein coding exons, which are used to fetch codon sequence triplets from the
reference sequence ﬁle. An amino acid change is derived from the variant position and the base
change (reported in the VCF ﬁle) in the fetched codon sequence. BasePlayer annotates synonymous,
nonsynonymous, nonsense, splice-site, frameshift, inframe, untranslated region (UTR), and intronic
and intergenic variants, and is compatible with Annovar annotation20. Adjacent genes are reported
for intergenic variants.

Materials
Equipment
A modern computer running Windows, Linux or macOS operating system with Java Runtime
Environment installed (64-bit recommended; http://www.oracle.com/technetwork/java/javase/
downloads/jre10-downloads-4417026.html)
● Internet connection (required for the installation of new reference genomes)
● Mouse with at least two buttons (recommended for smooth genome navigation)
● BasePlayer, available free of charge at https://baseplayer.ﬁ
Input data ﬁles for both example cases
○ The human reference genome (GRCh37) and gene annotation data for both example cases can be
downloaded from the Ensembl database (Release 87) as in Step 3.
Input data ﬁles for Case 1
○ VCF and BAM ﬁles from any exome- or genome-sequenced patients with a suspected inherited
disease. The example analysis was carried out with exome-sequencing data from meningioma
patients (Case 1), described in Aavikko et al.15. The publicly available data used in Supplementary
Tutorial 1 can also be used to test this case. Download the data from https://baseplayer.ﬁ/BPmanual/
content/analysis.html#inheritance. CRITICAL Note that these VCF ﬁles have the quality score
(QUAL ﬁeld) ﬁxed to 50 for all variants; thus it is not possible to use quality score as a ﬁltering
parameter when using this particular sample set.
○ The exome control ﬁles (both gnomAD_exomes_ALL_GRCh37.vcf.gz and the .tbi index) can be
downloaded from https://baseplayer.ﬁ/controls/. Initially, GnomAD variant frequency data were
downloaded via the gnomAD website (http://gnomad.broadinstitute.org/downloads)16.
36
○ M-CAP pathogenicity prediction data, described in Jagadeesh et al.
. The ﬁle ‘mcap_v1_0_forBP.
bed.gz’ can be downloaded from https://baseplayer.ﬁ/tracks/.
Input data ﬁles for Case 2
○ WGS
data for colorectal cancer samples and identiﬁcation of somatic variants (Case 2)
described in Katainen et al.11. European Genome-Phenome Archive (EGA) accession no.
EGAS00001003010.
41
○ ENCODE data for regulatory regions as published in Hoffman et al.
CRITICAL We merged the
data from six different cell lines (GM12878, H1-hESC, HeLa S3, Hep G2, HUVEC and K562) to
create the ENCODE annotation ﬁle.
18
○ Position-speciﬁc matrices for TFs obtained from Jolma et al.
and the JASPAR database42.
43
TF-binding sites for GRCh37, aligned with MOODS , and the ENCODE annotation ﬁle. Download
from the BasePlayer website (BasePlayer Download page at https://baseplayer.ﬁ/downloads.html,
under ‘Annotation tracks’).
c

c

●
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(iii)
(iv)

(v)

(vi)

Fig. 2 | The main window of BasePlayer, displaying three samples, a genomic region track and a population control
data track. Variant view of chromosome 10. (i) Toolbar contains tools for managing the data and navigating the
genome. (ii) Genome bar visualizes chromosome bands and genes. Reference sequence and gene annotation can be
changed from dropdown menus on the left. Memory usage shows the used and allocated memory for BasePlayer.
(iii) Region tracks are used to exclude and annotate variants. In addition, various types of regional- or base-speciﬁc
scores can be visualized as histograms and TF-binding motifs can be visualized as sequence logos. In this case,
tracks containing linkage-compatible regions and M-CAP annotations are opened. Clicking the red ‘play’ button will
apply the track; this will, by default, exclude any variants outside the region and annotate visible variants. See Case 2
(Step 4B(ii) and (iii)) and Supplementary Tutorials 2, 3 and 4 for more track options. (iv) Control tracks can be used
to exclude common polymorphisms by setting the allele frequency threshold such that variants whose allele
frequencies in the control data exceed the threshold are removed. (v) VCF and BAM ﬁles of the sample can be
overlaid for visualization. Sample name and statistics for currently visible variants are shown on the left. Vertical lines
represent variant calls in a sample, colored red, green (SNVs or indels in coding region, respectively) and gray
(variants in noncoding region). Height is relative to the sequencing coverage at the variant locus. (vi) Sample VCF
track is set as an annotation track. ClinVar data are opened in this case.

Additional Java packages
Htsjdk (v.1.141, https://github.com/samtools/htsjdk). BasePlayer uses Htsjdk index readers for BAM,
CRAM and Tabix indexed ﬁles. CRAM reader was optimized for BasePlayer by modifying
CRAMFileReader and related classes from the Htsjdk package.
● Index readers for BigBed and BigWig ﬁles. Download from https://github.com/lindenb/bigwig;
these were originally written by M. Decautis and J. Robinson for the Integrative Genomics Viewer
(Broad Institute)24.
●

Procedure
Download and install BasePlayer ● Timing 5 min
Download BasePlayer from https://baseplayer.ﬁ/downloads.html. Click the operating systemspeciﬁc installation package to start the download. Launch the installer and follow the instructions.
In case of insufﬁcient rights for your desktop computer to launch executable ﬁles, download the
portable multi-platform JAR package (‘BasePlayer portable package’) from the downloads page and
decompress it to a folder with writing permissions. To test the features of BasePlayer discussed in
this Procedure with example NGS data, download the ‘BasePlayer portable package with example
data’ from the downloads page or optionally family trio data (download links at https://baseplayer.
ﬁ/BPmanual/content/analysis.html#inheritance).
CRITICAL STEP Java JRE v.1.8 or a newer version is required to run BasePlayer. This procedure
was conducted with the portable JAR package and 64-bit Java Runtime Environment in a Windows
7 system.
? TROUBLESHOOTING
To start BasePlayer, click the BasePlayer executable (or optionally Launcher.jar with execute
permissions, if the portable package is used). If an updated version of the software is available
(green update button in ‘File’ menu), click ‘File’ > ‘Update’ to download the updated version and
restart the software (Fig. 2,i).
! CAUTION If the dataset to be analyzed contains >10 million variant calls, we recommend
allocating ≥2 GB of memory to the Java Virtual Machine for optimal usage. To increase memory
allocation, edit the BasePlayer.vmoptions ﬁle in the BasePlayer install folder. Instructions can be
found in the vmoptions ﬁle. When using the portable package and launching BasePlayer with the
Launcher.jar ﬁle, edit the ﬁle ‘conﬁg_baseplayer.txt’ in the user home directory of the operating

c
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system, changing the memory limit to, e.g., 4 GB (make sure that the 64-bit Java Runtime
Environment is installed on the system), and restart the program with Launcher.jar.
? TROUBLESHOOTING
When BasePlayer is launched for the ﬁrst time, a genome selector menu appears (note: if
‘BasePlayer portable package with example data’ was selected in Step 1, a reference genome is
already installed, and the genome selector menu does not appear). Select the preferred reference
genome and click ‘Download’. Revisit this menu by clicking the ‘Add reference genome…’
dropdown item on the left in the genome bar (Fig. 2,ii). If storing the downloaded genome is not
possible in the default location due to restricted permissions, select a folder in which to store the
genome ﬁle, when prompted.
! CAUTION Note that the example data provided in the ‘BasePlayer portable package with example
data’ contain only the reference sequence and gene annotation for human chromosome 20.
Furthermore, example samples are from healthy, unrelated individuals, and thus the results of Cases
1 and 2 in this procedure cannot be replicated with the example data as such. Instead, the example
data can be used to perform all the steps in this Procedure, even though the end result will be
different from what is shown in these procedures.
? TROUBLESHOOTING

NGS data analysis using BasePlayer
Use BasePlayer to analyze the NGS data by following option A to use Case 1 example data or option
B to use Case 2 example data.
(A) Case 1: ﬁnding a dominant pathogenic inherited variant using exome-sequencing data
● Timing 5 min
(i) Load the germ-line variant data by clicking ‘File’ > ‘Add VCFs’ and selecting the VCF.gz
ﬁles corresponding to cases (press ‘Ctrl’/‘Cmd’ or ‘Shift’ to select multiple ﬁles
simultaneously). Note that BAM ﬁles are opened automatically for the same samples, if
they are appropriately named and found in the same folder as the VCF ﬁles (Experimental
design). A chromosome-level variant view is now shown, with each sample displayed on a
separate track (Fig. 2).
? TROUBLESHOOTING
(ii) Annotate the variants using external resources. Open additional track ﬁles by selecting
‘File’ > ‘Add tracks’ to use in variant ﬁltering and/or annotation. Many of the standard ﬁle
formats are accepted (e.g., BED and bigWig). New tracks will be shown under the genome
bar (Fig. 2,iii). In our example, the track ﬁle (in BED format) contains linkage-compatible
regions for the studied family. Click the ‘play’ button on the left sidebar of the track to
remove variants outside the speciﬁed regions (intersect; default function). The intermediate
results after each ﬁltering step are shown in more detail in Supplementary Fig. 5. To predict
the possible pathogenicity of variants, add the mcap_v1_0_forBP.bed.gz ﬁle as a new track.
The ﬁle (and the index) can be downloaded from https://baseplayer.ﬁ/tracks/. Click the
‘play’ button on the left sidebar of the track to annotate the variants with the M-CAP scores
(see Supplementary Tutorial 4 and Supplementary Fig. 6 for the recommended usage of the
ﬁle). We have set the M-CAP score limit to 0.025 (recommended by the authors of the
method) in this case. To download and add the ClinVar annotation, see Supplementary
Tutorial 5 and Supplementary Fig. 7.
CRITICAL STEP The resources mentioned here work as an example, but users are not
limited to those. For instance, Table Browser in the UCSC Genome Browser (https://
genome.ucsc.edu/) is a comprehensive source for useful tracks that can be imported into
BasePlayer (see the instruction video ‘Loading external annotation resources to BasePlayer’
in our Youtube channel: https://youtu.be/nSQX2Ctwhso).
? TROUBLESHOOTING
(iii) Open a VCF ﬁle containing population variants by selecting ‘File’ > ‘Add controls’, which
opens a new track on top of the sample tracks (Fig. 2,iv). Here, we use an exome-speciﬁc
control genotypes ﬁle extracted from gnomAD16. The exome control ﬁle (gnomAD_exomes_ALL_GRCh37.vcf.gz and the .tbi index ﬁle) can be downloaded from https://basepla
yer.ﬁ/controls/ or from http://gnomad.broadinstitute.org/downloads (‘All chromosomes
sites VCF’ under ‘Exome Data’). First, set the allele frequency threshold (see ‘Experimental
design’ for further information) in the text ﬁeld on the left sidebar (0.001 in this case).
c
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(iv)
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c

d

e

f

Fig. 3 | Variant Manager user interface and functions. a, (i) Panels for variant quality ﬁltering, variant hiding and
sample-wise comparison. (ii) SNV and indel quality ﬁlters. Separate ﬁlters for indels can be activated in the ‘Indels’
tab; the same ﬁltering is used by default for SNVs and indels. (iii) Variant annotation panel, including gene effect and
output writing options. (iv) Result table shows a list of genes and variants that pass the ﬁlters set in the Variant
Manager, as well as any activated track. This view also includes tables for variant statistics and region track
annotations. b, Sample-wise comparison panel. The upper slider sets the minimum number of cases that must harbor
a variant in the same gene for these variants to be shown. It can thus be used if the sample set consists of cases with
a common disease, which might not share the same speciﬁc variant even though the same gene is mutated (e.g.,
sporadic cases or somatic mutations in cancer). The lower slider compares individual variants. For instance, the value
2/3 means that only variants shared by two or three (all) samples are included and visible on the screen. ‘Window
size for variant clusters’ sets the variant clustering behavior and will be demonstrated in Case 2 (Procedure).
c, Inheritance pattern selector. d, Sample data dialog, in which the user can change/set sample name, gender,
disease state and parents. e, Variant annotation options, which can be used to select the desired functional classes
and options for variants, which are included in the results. f, Output selector for variant annotation results. Here, the
user can select the desired output format for the result ﬁle.

Click the ‘play’ button to apply the control track. Variants appearing in the control ﬁle with
a higher frequency than the speciﬁed value are then excluded from the analysis and
removed from the screen.
(iv) To ﬁlter, compare and annotate the variants, click ‘Variant Manager’ on the toolbar
(Fig. 3). Use the sliders to set quality and coverage thresholds for the variants (Fig. 3a,ii).
These values depend on the data quality and research setting; we typically use values 20,
10 and 20% for the variant quality, coverage and allelic fraction thresholds, respectively
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(v)

(vi)

(vii)

(viii)

(ix)
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(see ‘Experimental design’ for further information), when analyzing germ-line data. Note
that ‘Min. quality score’ refers to the QUAL (Phred scale) ﬁeld and ‘Min. genotype quality
score’ refers to the genotype quality (GQ) ﬁeld in the VCF ﬁle. Quality values are given in
Phred scores and shown as reported by the variant caller that generated the VCF ﬁles
(GATK HaplotypeCaller in this example). Homozygous variants are ﬁltered out either by
setting the maximum allelic fraction to, e.g., 95%, by using the red handle of the ‘Min/max
allelic fraction’ slider (Fig. 3a,ii) or by selecting the ‘Hide homozygotes’ checkbox in the
‘Hide’ tab of ‘Variant Manager’.
Variant comparison between samples can be performed either by comparing variants or
mutated genes without prior knowledge of sample relations or by using inheritance
patterns of related samples and known disease statuses. The former option is commonly
used in sporadic and somatic settings or in any custom variant-management tasks, whereas
the latter approach is used in familial cases, when affected and/or unaffected relatives are
included in the sample set. In this example, the study can be conducted both ways, as all
individuals are affected and there are no parents available for the siblings. The ‘Compare’
tab in Variant Manager contains sliders for gene- and variant-level comparisons, which are
used to detect shared/unique variants, variant clusters and commonly mutated genes in
studied samples, regardless of the relations or disease statuses (Fig. 3b). The ‘Inheritance’
tab contains options for inheritance patterns, which are applied in annotation to output
only variants that are compatible with the selected pattern (Fig. 3c). To ﬁnd variants that
are shared among n cases without assumed inheritance patterns, click the ‘Compare’ tab in
Variant Manager and set the value of the ﬁrst slider to n (Fig. 3b). Because all samples used
in this example are ﬁrst-degree relatives and share the disease, the ‘Shared variants’ slider is
set to 3/3 (i.e., only variants shared by all samples are included and visible on the screen).
To apply inheritance patterns in variant annotation, at least one individual must be set
as affected. This is done in the ‘Sample data’ dialog (Fig. 3d), which appears by left-clicking
the sample name or right-clicking the left sidebar on sample tracks. In this case, all samples
are set as affected. The inheritance pattern, based on the segregation of phenotype in the
family, can be selected in the ‘Inheritance’ tab of Variant Manager (Fig. 3c). In this case, the
segregation suggests an autosomal dominant inheritance pattern, which is selected.
Annotate the candidate variants with gene information. At this point, variants are included
if they are heterozygous, of sufﬁcient quality, overlap linkage-compatible regions, are very
rare in the population, have an M-CAP score >0.025 and are shared by all cases or are
compatible with an autosomal dominant inheritance pattern (as determined in Step 4A(v)).
In this example, we are interested in nonsynonymous variants only and variants that
appear in any of the chromosomes: ﬁrst click the ‘Options’ button (Fig. 3a, iii) and then the
‘Only non-synonymous’ and ‘All chromosomes’ checkboxes (Fig. 3e). Begin the annotation
by clicking the ‘Annotate’ button. This will result in BasePlayer analyzing each of the
chromosomes and displaying the annotated variants in the ‘Genes’ tab (Fig. 3a,iii,iv). Using
the settings, controls and annotations selected above, the resulting candidate list consisted
of ﬁve mutations in ﬁve genes, of which the variant in SUFU had highest M-CAP score and
was not present in the gnomAD controls; it was subsequently found to be the prime
candidate meningioma-predisposing mutation in the family15 (Fig. 4a).
Write the list of candidate variants to a ﬁle by clicking the ‘Variant output’ tab, selecting
the preferred ﬁle format and clicking ‘Save’. The output list can be written in tab-separated
(TSV), VCF or OncodriveFML-compatible format (Fig. 3f) (more information is given in
the ‘Anticipated results’ section).
Read-level inspection of variants. Variants can be visualized and inspected in the
sequencing read data (if BAM ﬁles were opened in Step 1) interactively by double-clicking
the variant or gene in the result table (Fig. 4a). When the sample row is double-clicked in
the result table, BasePlayer expands the selected sample track and zooms in to the variant
locus (Fig. 4b). Reads will appear if a BAM ﬁle is available for the VCF ﬁle. If you doubleclick the ‘Multiple’ row in the result table, multiple samples are shown simultaneously. You
can expand and shrink the tracks manually by dragging the mouse to the top-right and
bottom-left corners (see ‘Browsing genome and samples with BasePlayer’ in our Youtube
channel: https://youtu.be/EJHZXLf6nQM).
Inspecting external resource annotation of variants. Data from annotation tracks can be
inspected in the result table either by selecting the corresponding tab or by clicking the
NATURE PROTOCOLS | VOL 13 | NOVEMBER 2018 | 2580–2600 | www.nature.com/nprot

PROTOCOL

NATURE PROTOCOLS
a

b

Fig. 4 | Candidate genes in the result table and variant visualization. a, Candidate gene list in the result table of the
Variant Manager. The ‘Mut. count’ column shows the total mutation count and the number of samples having a
mutation in the gene. Colored numbers in parentheses indicate mutation counts and effects in all isoforms; e.g., if a
gene has four isoforms overlapping three missense mutations, then the number 12 will be shown (in yellow) inside
the parentheses. The colors red, yellow, green, light gray and dark gray correspond to the mutation types frameshift/
nonsense, missense/inframe indel, synonymous, UTR and intronic/intergenic, respectively. Mutation information
can be expanded by clicking the gene name, which displays the genomic position, amino acid change, allele
frequency in the control ﬁle and enabled annotation tracks. Clicking the variant shows a VCF information pop-up,
which includes a link to the VarSome website and annotation VCF track data (ClinVar in this case). Double-clicking
the gene or mutation will zoom in the sample track view to the selected locus. b, Sequence-level zoom of the SUFU
mutation. The VCF information pop-up can also be opened by clicking the variant in the sample track (vertical red
lines).

gene (Fig. 4a). For instance, the selected variant in Fig. 4a has an M-CAP score of 0.34,
overlaps the linkage region and has an allele frequency of 0 in the gnomAD control ﬁle.
Click the variant for more information (VCF information pop-up). ClinVar data are shown
for this variant alongside the VCF information. Click the ‘Show variant in VarSome (hg19)’
to open the VarSome website (https://varsome.com) for the variant locus (registration may
be needed). VarSome lists and visualizes a number of additional annotations from multiple
sources, such as dbSNP, ClinVar, ICGC, Cosmic and PubMed, as well as multiple
pathogenicity predictors.
(B) Case 2: somatic mutation clusters in the regulatory genome ● Timing 10 min
(i) Load the somatic variant data by clicking ‘File’ > ‘Add Samples’ and selecting the VCF.gz
ﬁles. BAM ﬁles are opened, if available, automatically for the same samples as used in Case
1 in Step 4A(i).
? TROUBLESHOOTING
(ii) Add a track ﬁle for regulatory regions by clicking ‘File’ > ‘Add tracks’. In this example, a ﬁle
containing regulatory annotations deﬁned by the ENCODE Project is used. This ﬁle can be
downloaded from https://baseplayer.ﬁ/tracks/. Variants and the ENCODE regulatory
regions are now loaded and appear on the screen (Fig. 5).
? TROUBLESHOOTING
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Fig. 5 | Somatic variants in the regulatory genome. All somatic single-nucleotide variants of 190 colorectal cancers (WGS) in chromosome 1 are
visualized. Additional track in the middle visualizes ENCODE regulatory regions, color-coded as: blue, CCCTC-binding factor (CTCF) binding sites; dark
yellow, enhancers; light yellow, weak enhancers; red, transcription start sites; and light red, promoter ﬂanks.

(iii) Add another track ﬁle, which contains predicted or measured binding sites of TFs relevant
to the disease under investigation. In this example, we use binding sites for hundreds of
TFs contained in the ﬁle TFbinding_sites_SELEX_GRCh37.bed.gz (track and index ﬁles
downloadable from https://baseplayer.ﬁ/tracks/)18.
(iv) Open Variant Manager and adjust the preferred ﬁltering thresholds (see ‘Experimental
design’ for further information) for your samples (Fig. 6a). Depending on the estimated
tumor purity of the samples, minimum allelic fraction should be set accordingly; the
settings used here are shown in Fig. 6. In this example, we exclude indels from the analysis
by clicking ‘Hide indels’ under the ‘Hide’ tab, because indels at low-complexity regions
(e.g., microsatellites) would otherwise cause an excessive amount of nondesired variant
clusters genome-wide (Fig. 6b).
(v) Adjust the variant clustering settings in the ‘Compare’ panel (Fig. 6c). Set the window size
for variant clusters at the bottom of the compare panel (50 bp in this example); this is the
maximum distance between consecutive clustered variants. A cluster is deﬁned as a set of
variants in which the distance between any two adjacent variants does not exceed the
window size. Note that the cluster width (distance between the left-most and right-most
variant) can thus exceed the window size. The ‘Common variants’ slider is used to set the
minimum number of variants in a cluster (Fig. 6c).
(vi) Adjust the settings for the regulatory region track by clicking the cogwheel symbol in the
left sidebar of the track (Fig. 6d). In this example, we use the default options. When the
‘Intersect’ option (the default) is selected, variants outside the regions speciﬁed by the track
are excluded and hidden on the screen. When the ‘Subtract’ option is selected, variants
inside the region are excluded. After the options have been set, apply the track by clicking
the track’s play button.
(vii) At this point, somatic SNVs that overlap the ENCODE regulatory regions and belong to a
variant cluster consisting of at least four variants are included and visible. In each variant
cluster, any two consecutive variants are at most 50 bp apart. Click ‘Show intronic’, ‘Show
intergenic’ and ‘Show UTR’ to include all noncoding variants in the results (Fig. 6e). Scan
all mutation clusters genome-wide by clicking ‘Annotate’ in Variant Manager.
(viii) The results are listed in the result table of the ‘Clusters’ tab in Variant Manager (Fig. 7a).
Double-click a cluster or individual variant to jump to the genomic location of the
cluster or variant (Fig. 7b). If TF-binding data are added as a track (Step 4B(ii)), then
TF-binding motifs are shown in the track when zoomed in to nucleotide resolution
(see Supplementary Tutorial 2 and Supplementary Fig. 3 for afﬁnity change annotation
using TF-binding data).
2592

NATURE PROTOCOLS | VOL 13 | NOVEMBER 2018 | 2580–2600 | www.nature.com/nprot

PROTOCOL

NATURE PROTOCOLS
a

b

c

d

e

Fig. 6 | Variant Manager settings in somatic cluster analysis. a, Example of ﬁltering settings for somatic variants.
‘Min. allelic fraction’ is set to as low as 5% to include subclonal variants in the cluster analysis. b, Indels are excluded
from the analysis, as they produce an excessive amount of clusters at low-complexity regions of the genome.
c, Window size is set to 50 bp, which determines the maximum distance between two adjacent variants in a cluster.
The shared variant slider is used to exclude any cluster with fewer than four variants. d, Default values of annotation
track options. ‘Intersect’ and ‘Subtract’ options are mutually exclusive. If both are unchecked, variants are still
annotated when the track is applied. e, With these settings, all noncoding mutations in all chromosomes will be
annotated.

(ix) Visual validation of variants. Variant-quality metrics in VCF ﬁles are provided by
the used variant caller. Although the false-positive rates of variant callers have decreased
as methods have improved, read-level inspection of variant calls and ﬂanking regions
is still often required. In particular, low-allelic-fraction somatic mutation calls in the
noncoding genome, as in this case, should be inspected visually. The integrated variant
analysis and visualization in BasePlayer enables rapid workﬂow for variant validation;
double-click the speciﬁc sample in the result table to zoom in to the variant locus
and expand the sample track. Reads appear on the sample track (Fig. 8) if a BAM/CRAM
ﬁle is opened alongside the VCF ﬁle (Step 4A(i) and (vii)). Using read-level zoom,
inspect the qualities, orientation and mismatch rates of the overlapping and surrounding
reads. In more ambiguous cases, read-level inspection among multiple samples can be
NATURE PROTOCOLS | VOL 13 | NOVEMBER 2018 | 2580–2600 | www.nature.com/nprot

2593

PROTOCOL

NATURE PROTOCOLS
a

b

Fig. 7 | Somatic clustering results. a, The ‘Clusters’ tab shows a list of all annotated mutation clusters. b, Motif
visualization with JASPAR and SELEX data. Closer inspection of the cluster highlighted in Katainen et al.11 shows
mutation hotspots at an occurrence of the CTCF-binding motif.

useful; you can visualize reads from multiple samples easily in BasePlayer by scrolling
through the samples and shrinking the sample tracks (see example in Fig. 4b). In
addition, the reference sequence and annotation tracks, such as the ‘repeat masker’ and
‘mappability’ tracks, provide additional information about variant calls when inspecting
variant quality.
(x) Write the cluster analysis results to a TSV ﬁle by clicking ‘Variant output’ and ‘Save’ in
Variant Manager.
? TROUBLESHOOTING
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Fig. 8 | Variant quality validation by read-level inspection. Light red and green read colors indicate reverse and forward orientations, respectively.
Mismatches in reads are colored accordingly. Read information is shown in a separate dialog (top-left), which is accessed by clicking the read (yellow
outline on selected read). Coverage information is located on top of the reads, which shows position-speciﬁc coverages and fractions for alternative
alleles, derived from the overlapping reads. Read and coverage information is fetched from the BAM ﬁle and variant call (white bar behind reads)
information from the VCF ﬁle. More-detailed variant information is shown in a separate ‘VCF info’ dialog, if a variant is clicked. For additional
annotation, click on the ‘Show variant in VarSome (hg19)’ button.

Troubleshooting
Troubleshooting advice can be found in Table 1.

Table 1 | Troubleshooting table
Step

Problem

Possible reason

Solution

1

Installer does not start

The installer ﬁle may not
have the necessary ﬁle
permissions

2

BasePlayer does not start

Operating system does not
have Java Runtime
Environment installed
The launcher ﬁle does not
have execute permission

Set the execute permission to the installer ﬁle and run
again. Alternatively, download BasePlayer.zip, unzip it
and use Launcher.jar to start the program. The JAR
launcher is required for Linux systems. In macOS, click
the launcher ﬁle while pressing the ‘Ctrl’ key
Download and install the Java Runtime Environment
from http://www.oracle.com (a 64-bit version is
recommended)
Set the execute permission to the launcher ﬁle and run
again. If the Launcher.jar ﬁle is used and does not work,
start the program using the command line: java-jar
Launcher.jar
Download and install a 64-bit version of Java Runtime
Environment to allocate >1.2 GB of memory to
BasePlayer. We recommend 2 GB for larger projects

BasePlayer does not start

BasePlayer does not start

BasePlayer does not start

Launcher.jar does not launch the
software

Installed Java Runtime
Environment is incompatible
with the requested memory
allocation
macOS Gatekeeper does not
open applications from
‘unidentiﬁed developers’
macOS may have Java
compatibility issues
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The instructions for dealing with this issue can be found
at https://www.imore.com/how-open-appsunidentiﬁed-developers-mac
Launch the program with BasePlayer.jar or use the
macOS installer and launch with BasePlayer launcher.
Note that memory allocation cannot be increased when
BasePlayer.jar is used to launch the software
Table continued
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Table 1 (continued)
Step

Problem

Possible reason

3

A genome ﬁle cannot be
downloaded

Ensembl server is unavailable Test the server in the web browser by entering
‘ftp://ftp.ensembl.org/’ in the address bar. If the server
is unavailable, try downloading the genome later
Downloading or processing
Delete the genome ﬁle by clicking ‘File’ > ‘Genomes’ >
of the genome ﬁles may
‘Add new genome’, selecting the invalid genome and
have been interrupted
clicking ‘Remove’. Download the genome again. The
genome can also be removed manually by deleting the
genome folder in the Genome directory
No read permissions for the Set the ﬁle read permissions on the VCF and the index
VCF or index ﬁle
ﬁles
VCF ﬁle is not compressed
If an uncompressed, unindexed VCF ﬁle is opened,
with bgzip or is not sorted
BasePlayer will try to create an index before opening
the ﬁle. An index ﬁle will not be created if the VCF ﬁle is
unsorted or there are no writing permissions for the
index ﬁle in the folder. Sort the VCF ﬁle with the Unix
command ‘sort -k1,1 V -k2,2n sample.vcf
>sample_sorted.vcf’. bgzip ﬁle with the Unix command
‘bgzip sample_sorted.vcf’. Give the VCF-containing
folder writing permissions and open the ﬁle again
VCF and/or index ﬁle is
Check the VCF ﬁle manually (in Linux, use zless or tabix
corrupted
commands). If necessary, regenerate the VCF and/or
index ﬁle
Default ﬁltering thresholds
Go to Variant Manager and set ‘Min. coverage’ and
may be too high
‘Min. allelic fraction’ to 0. If no variants show up despite
this, check that there are variants in the selected
chromosome and that the VCF/index ﬁles are not
corrupt
File naming may be incorrect Make sure that the BAM, VCF and index ﬁles share a
ﬁle name preﬁx, e.g., ‘sample.bam’, ‘sample.bam.bai’,
‘sample.vcf.gz’ or ‘sample.vcf.gz.tbi’, and rename the
ﬁles if necessary
Problem may be the same as See the VCF ﬁle troubleshooting steps reported above.
with VCF ﬁles
If necessary, check the BAM ﬁle manually using the
‘samtools’ command
Problem may be the same as See VCF ﬁle troubleshooting steps reported above. If
with VCF ﬁles
necessary, check the BED ﬁle using any text editor
Somatic variants are not
Somatic variants should be reported in the last column
found in the last column of
of the VCF ﬁle. Remove all other columns, except for
the VCF ﬁle
the one containing the somatic variant genotypes
No writing permissions to
Set writing permissions to the target folder
the folder
No variants passed the ﬁlters If no variants show up in Variant Manager, loosen the
analysis criteria and try to annotate the variants again
and analysis parameters
Memory consumption
Increase the allocated memory for BasePlayer. We
exceeds the maximum
recommend using at least 2 GB when using a CADD
allocated memory
annotation. Alternatively, go to ‘Tools’ > ‘Settings’ >
‘General’, change ‘Processing window size (bp)’ to
100,000 and press the ‘Enter’ key
The mouse has only one
In some Mac systems, the mouse does not have a
button
right button. Press the ‘Ctrl’ key while clicking
with the mouse. More instructions are available at
https://www.wikihow.com/Right-Click-on-a-Mac

A genome ﬁle is corrupted or
does not work

4A(i) and B(i)

VCF ﬁle does not open
VCF ﬁle does not open

VCF ﬁle does not open

Variants do not show on the
sample track

BAM ﬁle is not recognized

BAM ﬁle does not open, or reads
are not shown

4B(x)

BED ﬁle does not open, or regions
are not shown
Somatic variants are not shown
when opening VCF containing
somatic variants
Cannot write an output ﬁle

4B(x)

Output ﬁle is empty

4A(i)

Supplementary
Annotation fails when using a
Tutorial 3 (Step v) CADD track ﬁle. Error message:
‘Memory allocation exceeded in
Annotating variants with
<ﬁlename>’
Supplementary
Cannot right-click or scroll the
Tutorial 3 (Step v) screen vertically with the right
mouse button

Solution

Timing
Step 1, software download and installation: 1 min
Step 2, starting BasePlayer: 10 s
Step 3, downloading and unpacking the human genome FASTA and gene annotation GFF3 ﬁles: the
duration of downloading these ﬁles (~950 MB) depends on the Internet speed (~3 min); unpacking takes
1 min
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Step 4, genome-wide variant analysis and gene annotation for ten exome samples (~3 million variants)
+ gnomAD exome control: 2 min
Step 4, genome-wide variant analysis and gene annotation for ten WGS samples (~50 million variants)
+ gnomAD genome control: 15 min
Step 4, genome-wide variant analysis and gene annotation for ten WGS samples (~50 million variants)
+ gnomAD genome control and binding afﬁnity change calculation: 90 min

Anticipated results
Case 1 (Step 4A)
Parameters and sample ﬁles used as an example in Case 1 produced a list of ﬁve shared variants in
ﬁve genes. By contrast, variant annotation using the same samples, but without any ﬁltering or other
settings applied, would output a list of 9,913 mutated genes. The ﬁnal variants are very rare in the
population, reside in linkage-compatible regions and have been predicted as damaging by M-CAP. In
general, the anticipated result in a familial study with at least two cases and population-speciﬁc
controls is a small set of candidate mutations or genes. These mutations or genes can then be taken
forward to functional validation or genetic validation in extended sample sets, for example.
Case 2 (Step 4B)
The analysis conducted in Case 2 resulted in a total of 300 mutation clusters within the ENCODE
regulatory regions genome wide, each cluster containing four or more somatic variants. The
anticipated result is the detection of recurrently mutated regulatory regions, with mutations potentially affecting the expression of nearby genes. The analysis performed here revealed an unexpectedly
high mutation frequency at the binding sites of CTCF/cohesin11. In general, BasePlayer can be used in
this fashion to integrate genomic information from multiple sources with the goal of narrowing down
the set of candidate variants, genes or genomic regions by using TF-binding and/or tissue-speciﬁc
open chromatin and super enhancer regions, for instance. Indeed, the possibility of using tissuespeciﬁc annotation and ﬁltering tracks is an instrumental feature in noncoding variant analysis. Upon
visual inspection, the locus shown in Fig. 8 is an example of a robust variant call; both read orientations call the variant, the underlying reference sequence does not contain microsatellite or similar
repeats, read mapping qualities are at maximum (60) and reads do not show an excessive amount of
mismatches or soft clips.
Inheritance patterns
Inheritance pattern analyses can be performed when at least one individual in the opened samples is
set as affected. The following possible inheritance patterns can be returned as results, which assume
that no additional annotations or population controls are used: autosomal dominant—heterozygous
variants that are shared only by affected individuals; recessive—variants compatible with compound
heterozygous, homozygous and X-linked recessive inheritance patterns; and homozygous recessive—
homozygous variants shared by all affected individuals such that unaffected individuals must be
heterozygous or homozygous reference; compound heterozygous—heterozygous variant combinations in a gene or intergenic regions such that the combinations are not present in unaffected
individuals; X-linked recessive—homozygous variants shared by all affected individuals in the
X chromosome such that an unaffected father is homozygous for the reference allele; de novo—
heterozygous variants found only in the child (both parents must be speciﬁed for the child).
In addition, when utilizing the annotation and population controls described in the Procedure, the
following results can be anticipated:
Autosomal dominant—with annotation—coding region
Missense/nonsense, heterozygous variants, which are very rare (allele frequency <0.001) in the
population and shared only by the affected individuals. These variants are predicted to be damaging
to the protein product, are conserved among primates and are recognized by the Cancer Gene
Census, as well as being called in regions with good mappability.
Autosomal dominant—with annotation—noncoding regions
Missense/nonsense, heterozygous variants, which are very rare (allele frequency <0.001) in the
population and shared only by the affected individuals. These variants are predicted to decrease the
afﬁnity score of overlapping TF-binding sites, are conserved among primates and occur in enhancer
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regions identiﬁed in six cell lines in the ENCODE Project as well as being in DNA regions accessible/
open in the epithelial tissue.

Output ﬁles
Variant and sequence data can be analyzed and results outputted in various ways, depending on the
type of analysis. BasePlayer is able to output a list of variants that survive quality, control and region
ﬁltering, and satisfy other criteria such as the requirement for a minimum number of shared variants.
The resulting variant lists can be written in TSV-, VCF- or OncodriveFML-speciﬁc format. For each
variant, the TSV ﬁle reports variant annotations such as chromosomal position, base and possible
amino acid change, the gene name or ﬂanking genes, quality scores, genotypes, sequencing coverage,
allele frequencies and odds ratios (when a control ﬁle is used) and annotation track items that overlap
the variant (when an annotation track is used). The VCF output enables the user to create ﬁltered
VCFs for downstream processing in other tools or, for instance, to create a multi-sample VCF to
be used as a BasePlayer control ﬁle. BasePlayer also provides a TSV output format accepted by
OncodriveFML, which is a tool used to identify cancer driver mutations31.
Variant statistics can be written to a ﬁle when the ‘Stats’ tab is selected in Variant Manager
(Fig. 3a,iv). These statistics include variant counts for different mutation types, the transition/
transversion ratio, average allelic fractions and the heterozygous/homozygous ratio. The user can
output variant context counts to a separate ﬁle for mutation signature analysis by selecting ‘only stats’
and ‘output contexts’ in the Variant Manager options (Fig. 3c). Variant contexts are reported
as sequence triplets (e.g., TpCpA>TpGpA), followed by the number of respective context-speciﬁc
variants for each sample23.
Sequencing coverage statistics for BAM ﬁles can be calculated with ‘Coverage calculator’, accessible
in the ‘Tools’ menu (Fig. 3a,i). The regions to be included in the calculations must be speciﬁed using a
BED ﬁle (e.g., exome target regions). The coverage calculation gives values for average sequencing
coverage and mapping quality, as well as the percentage of the total targeted area that is covered. The
coverage calculation also provides additional read statistics, such as the proportions of soft clipped
and zero mapping quality reads out of all reads.
Reporting Summary
Further information on experimental design is available in the Nature Research Reporting Summary
linked to this article.
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